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Getting Started
If you have not yet done it, the first step is to run the Setup program to install On Top Of The 
World.

When you first start it,    On Top Of The World will probably ask you to set or confirm the time 
zone that your computer's clock is set to.    After that, you should see a view of the earth, centered
over your home country, with the daylight side of the earth correctly depicted as it would appear 
right now from space.

With this done, it is time to start exploring the world.    It is easy, and there is help available for 
every menu and for most of the dialogs.



What Is On Top Of The World?
On Top Of The World is an easy way to explore our earth on your    computer.    Unlike other 
geography programs, On Top Of The World has no maps.    Instead, it lets you fly around a 
colorful 3 dimensional model of the earth, whose position and sunlit side are correctly depicted 
for the time and date. On Top Of The World combines the fun of a    flight simulator with learning
about our world.    It is a bit like having your own camera in space to send you live pictures, but 
it can move instantly, can travel in time, and knows the names of thousands of features.

All world maps are distorted because they are flat and the world is not. Many different map 
projections have been invented, but all have distortion of some kind. Globes, and On Top Of The 
World solve this problem by depicting the world as a sphere.



What Is New?
This is On Top Of The World for Windows, Version 2.0. It is based on On Top Of The World for 
DOS, but has many improvements :

It is a fully integrated Windows application.
You can add your own permanent features    on the world.
You can add your own notes about features.
You can play    and record demo files.
Help is much more complete.
Lots of smaller improvements.



Exploring The World
Now that you can see the world as it appears from space, you will want to get close and explore.  
The easiest way to move around is to use the button bar    or the arrow keys on the keyboard. 
Once you are down close, you will want to try looking in different directions. The easiest way to 
do that is to use the arrow keys or the compass icon. 

To find out the names of the things you see, just click on them.      There are over 5000 named 
features, or places to see. If you know the name of a place, and want to find it, use the find dialog
in the feature menu.

Another way to move around is to double click on the globe.    That causes you to move directly 
over the point you clicked.

An especially exciting way to explore the world is to take a simulated Space Shuttle ride.

You can explore in time as well as space,    to see how the earth turns and how the seasons 
happen.



These are the top level menu commands :
File,View,Feature,Show,Options,Time.
(Show and Options disappear when the main window is small.)



File Menu
Saving and Restoring Data from Disk

Save for Start
saves the current view of the world to be restored automatically    the next time On Top Of The 
World is started.    If you want a particular view to appear    each time you start, this is how to set 
it. 

Delete for Start
wipes out the view that was stored by Save for Start. After that, On Top Of The World instead 
starts with a view of the world from above your home country.    Your home country    is the one 
set in Windows Control Panel, International settings. 

Restore Last
restores the last view from the last time On Top Of The World was run.      This lets you continue 
exploring just where you left off last time. 

Record Demo
lets you record a single view or a series of views, to be played back later.    You can type in some 
text which will be shown when the view is played back.

When you record just a single view, this is a way to save your    position and other settings, to 
return later.    When you record a series of views, this is useful for illustrating a concept. There is 
a prerecorded demo to illustrate how the    seasons work, and another general introductory demo.

Play Demo
plays a series of views recorded by the Record Demo command.    Each view appears on the 
screen for a few seconds. 

Write BMP
lets you save a bitmap of the current view.    It's like taking a snapshot.    The bitmap is in the 
standard BMP format that can be used by any    Windows program that accepts bitmaps.    On Top
Of The World cannot read it in again, however. 

Exit
quits On Top Of The World.    Your last view is automatically saved, and you can restore it next 
time by choosing Restore Last. This lets you continue exploring just where you left off this 
time. 



View Menu
Change Your View of the World 

Move...
displays the position of your viewpoint and lets you change it    by typing in coordinates.    The 
arrow buttons    or the arrow keys on the keyboard    are a quicker and easier way to move.

Direction...
displays the direction of your view and lets you change it by typing    in angles.    It is probably 
easier to use the arrow keys or the compass icon for this. 

Grid Incr
lets you adjust the spacing in degrees between the    latitude and longitude grid lines.    The 
smaller the spacing, the more lines you see.    The closest spacings are only available at low 
altitude.

Land Style
lets you choose a physical or a colorful political view. 

Colors
lets you choose the colors of the Grid (latitude and longitude lines),    the Tropics (equator, 
tropics of Cancer and Capricorn, and the Arctic and    Antarctic circles.), Borders between 
countries, and Cities. 

Night
lets you display the night side of the earth as    black, dark, or light,    all of which are darker 
than the day side. 

Texture
turns on or off the texture of the land.    If small features are hard    to see, you may want to turn 
off the texture. 

Split Countries
controls the coloring of the states or provinces of the largest countries. If checked, states or 
provinces will be colored using the same distinctive colors as countries. Otherwise, they will be 
colored in shades of the    the same color, to show that they belong together. These shades will 
only be visible when operating in 256 or more colors.



Feature Menu
Anything to do with Features, or Places on the earth

Find...
lets you find places by typing their names. 

Phone & Radio...
lets you find the locations of telephone area codes, country codes, and radio call signs.

Recently Visited...
keeps track of all the places you have recently visited, in reverse order.    If you want to return to 
one, just choose it and hit the appropriate button,    or double click. 

Info...
displays a Help screen describing any country or any state of the USA, or province of Canada. 
This is a hypertext verion of the CIA World Factbook.    The country or state being described is 
the one displayed in the status bar. You can read but not change this text.    If the current feature 
is smaller than a country or state, then the information will be about the country or state that the 
current feature    belongs to.

Notes...
displays a box of text that you entered about the current feature or    place, and lets you edit it, or 
add more text. The text is specific to the feature    that is being displayed in the status bar. 

Add Custom...
lets you add your own feature or place.    Only point features can be added. Cities, mountains, 
and airports are examples of point features.

Delete Custom
lets you delete a feature or place that you added.    You cannot delete the ones that are built in to 
On Top Of The World. 

Quiz
lets you test you knowledge of geographical features. If quiz is checked,    when you click on a 
feature, a dialog box pops up with several possible    names.    You choose one, and your correct 
responses are counted.    This can be    very easy or very hard.    If Quiz is not active, clicking on a
feature causes    its name to appear in the status bar. 

Reset Quiz
clears the counts of correct and incorrect responses to the quiz. 



Show Menu
This menu lets you turn on or off the following things:

ButtonBar
Compass
Feature Window
Great Circle
Time Bar and Feature Bar: (Status Bar) Label On Screen



Options Menu
Identify...
controls what kind of features are named when you click your    mouse cursor on them. 

Units
lets you choose kilometers, miles, or nautical miles for displaying distances. 

Degrees
can be displayed as degrees with minutes (The traditional way to express fractional degrees.), or 
as decimal degrees, which are much easier to calculate with. 

Distance Origin
lets you choose the beginning point of the distance calculation and of the    Great Circle route (if 
displayed). The choice is between a Fixed point, or the Previously    visited point.

Set Origin
sets the current point to be the beginning point of the distance    calculation and the Great Circle, 
but this only has effect if the Distance Origin is Fixed. 



Time Menu
This menu gives you control over time.    Normally time is just true clock time, but you can set 
On Top Of The World to display    the earth as it would appear at any time or date.    Don't worry : 
any    changes you make to time here only affect On Top Of The World.    Your computer's clock 
will not be changed. 

Speed Factor...
lets you control the rate that time passes in On Top Of The World. 

Zone and DST...
lets you set the time zone that is used for the time display in the    status bar. 

Set Time...
lets you set the time that the world view depicts.    This has no effect on    the computer's clock 
time. 

Set Date...
lets you set the date that the world view depicts.    This has no effect on    the computer's clock 
date.    You are limited to the years between 1 and 9999. 

Reset To Now
sets the date and time back to the true present time.    It also sets the Speed Factor to 1, so the 
time will stay true.

Set Home Zone...
should only be done once, unless you move to another time zone.    This sets the home time zone 
that your computer's clock is set to. 



Recording a Demo
The Recording Demo dialog in the File menu lets you record a demo file, which is just a scene or
a    series of scenes that can be played back by On Top Of The World.

To record a demo, choose your first scene by setting up a view of the world.    Then press 
Record to save the current view of    the world.    Enter some text to describe it, and enter how 
long it should stay on screen. Then set up a new scene and Record it.      When done, press 
Done.    To edit a demo, use    Back, Forward, Delete to find scenes and replace them.



Playing Demo
The Playing Demo dialog in the File menu controls the playing of a demo, which is a set of 
scenes. When playing a demo, each scene appears on the screen a pre-set number of seconds.    
When all the scene have been shown, the demo pauses,    unless you set it to in loop mode, in 
which case it will start again, and continue until you stop it.    The number in the lower right is 
the number of the current scene.    When you start or restart a demo, it will    automatically play 
without looping.

 Quit the demo and return.

 Start the demo from the beginning.

 Go back one scene.

 Stop or pause the demo.

 Play, stopping at the end.

 Play in a continuous loop.

 Skip to the next scene.

 Pause, and display this help screen.
Note that in any scene time may be running fast, and the view may be    constantly changing.    
Stopping the demo does not stop the action.



Move
The Move dialog in the View menu displays the position of your view point    above the earth, 
and lets you change it by typing in new values. The view point has three coordinates :
 latitude in degrees,
 longitude in degrees,
 Altitude, which is given in kilometers, miles, or nautical miles, depending on the Units setting in
the Options menu.    The altitude must be between 250 km and 15000 km.

The arrow buttons    or the arrow keys on the keyboard    are a quicker and easier way to move. 
Another way to move around is to double click on the globe.    That causes you to move directly 
over the point you clicked.

Move With lets you choose:

Sun : means your view point is fixed in space with respect to the Sun, so that the earth rotates 
below you.

Earth : means your view point rotates with the earth so you are fixed above a point on earth.    

Orbit : means your view point is on a simulated spacecraft in a circular orbit around the earth. 

Travel By lets you choose how you move when using the arrow buttons    or the arrow keys. 

Sight : means you travel in the direction you are looking.    This appears    natural, but it means 
your azimuth (compass heading) changes while traveling, especially near the poles.

Lat - Lon : means you travel along    latitude or longitude lines.    This has the advantage that 
your azimuth    (compass heading) does not change as you travel. This can appear strange when 
you are near the North or South poles.



View Direction
The View Direction dialog in the View menu displays and lets you adjust your    elevation and 
azimuth, which may be easier to adjust with the Compass window.

This dialog also displays and lets you adjust your tilt and zoom,    and this is the only way to do 
that.    Tilt causes the whole view to be tilted, or even upside down.    You probably want to keep 
tilt at 0.

Zoom lets you adjust the angle of view.    It works like the zoom control on a 35mm camera 
lens.    A setting of 35 or less is usually best.



Color Choose 
The Color dialogs in the View menu let you change the color of the grid, tropics, borders, or 
cities. Just click on the appropriate icon and press OK.    You can also turn off each item by 
choosing the first icon.

If you click on Political, the colors of countries will swap with each other. You may click this 
repeatedly to find a color arrangement you like.



Find
The Find dialog in the Feature menu lets you find features or places anywhere in the world. To 
find a feature, type in its name, or just the first few letters of its name.    To control the kinds of 
features that are found, check the desired boxes.    When you press the OK button,    another 
dialog pops up listing all the features that were found that start with the name you gave. Press 
Go To to go to the feature,    or Don't Go to make this the current feature in the status bar, but 
not go there.

If you type "York" you get New York, as well as York, so you can find a feature by using just one
word of its name.

If you type something like "New", you may get so many matches, they will not all fit in the list.

To control the kinds of features that are found, check the appropriate boxes in Kinds of 
Features to Find.    This list is just like the one in the Identify dialog, but the two lists are 
completely independent. That means your settings here do not affect the Identify list.Physical 
Areas means things like mountain ranges, deserts, and wetlands.Airports and Dams refers to 
any man-made object except cities.

You can also control where features are found.    Global    means anywhere on earth. Local 
means closer than the    horizon of your current view point.



Telephone Codes and Radio Call Signs
This dialog in the Feature menu lets you find the locations for telephone area codes in North 
America, and telephone country codes for anywhere in the world. You can also find the country 
for radio call signs anywhere in the world. Aircraft registration numbers are their radio call signs,
so you can use this to find out where any airplane is registered.

To find the location of an area or country code, type in the complete code and press the Area 
Code or Country Code button. To find the location of a radio call sign, type in the first few 
characters    of the call sign, and press the Call Sign button. In either case    the location now 
appears below the buttons.

Press Go To to go to the location,    or Don't Go to make this the current feature in the status 
bar, but not go there.

If the Feature Window is turned on, the location also appears there, along with the distance and 
azimuth from the previous location. See Distance and Direction for more    information.

If you know the location, and want to find out the area code, click on info. Info gives the area 
codes for each U.S. state and Canadian province. 



Identify
The Identify dialog in the Options menu lets you control what is identified. When you click your 
mouse on the world, the name of the country    you are in, or the nearest place or feature appears 
in the status bar.    If you want to control the kinds of places that are identified this way, you can 
turn on or off the appropriate check boxes.

If the Quiz is on, this controls the features that you are quizzed on.

If you turn off all the boxes, then only the    latitude and longitude are displayed.

This list is just like the one in the Find dialog, but the two lists are completely independent. That 
means your settings here do not affect the Find list. Physical Areas means things like 
mountain ranges, deserts, and wetlands. Airports and Dams refers to any man-made object 
except cities.



Notes
The Notes dialog in the Feature menu lets you enter text about any feature or place on earth. 
These notes are permanent, unless you delete them. When you first install On Top Of The World, 
all the notes are blank.    This is your chance to add your own notes about the places you visit.    
Each note belongs to just    one feature, and you must find that exact feature again to find the 
note. Two different features with the same name have two different notes. Any feature can have a
note, not just countries or states.



Add Feature
The Add Feature dialog in the Feature menu lets you make your own feature or place, which 
becomes a permanent part of On Top Of The World's data, until you delete it.    You can add as 
many features as you like.

You can only create point features, that are displayed as dots or symbols.    You can choose the 
Kind Of Feature,    and give it a Name, which can be anything that fits in the box.

The location of the feature is where you last clicked your mouse on the world. The latitude and 
longitude of the location is displayed here, and you can type in a new one, or you can Cancel, 
and click on a new location.

You should be below 1000 km altitude    when you add a feature, to make sure the location is set 
accurately.



Quiz
This dialog presents possible names for the place that you have clicked on.    Choose one of these
names and push the Check Answer button.    A message appears telling if your choice    was 
right or not.

If you want to control the kinds of features that the quiz finds, use the Identify dialog.

You can turn Quiz mode on and off in the Feature menu.



Speed Factor
This Speed Factor dialog in the Time menu lets you change the speed that time passes in On Top 
Of The World.    Normally, the time is the true time, so if you want to see the earth actually spin, 
you have to speed up the passage of time. If you speed up time to 720 times normal, for example,
you can see a complete day pass in two minutes.

 For true time, the speed factor must be set to 1.    You can also Stop time, so the view will not 
change.



Time Zone and Daylight Savings
The Time Zone and DST dialog in the Time menu lets you control for which time zone the time 
is displayed, and whether Daylight Savings Time is displayed.    This only affects the time 
displayed on the status bar, nothing else.

Time Zone for Display buttons let you choose the time zone that is displayed on the status 
bar : Universal, Local, Home, or stay on the currently displayed time zone. If you want to stay on
a time zone that is not displayed, choose Local, then OK.    Then click on a place that uses the 
time zone you want, and finally use this dialog again to choose the currently displayed zone.

Daylight Saving buttons let you choose whether the time displayed on the status bar adjusts 
itself for summer.    Most locations in the world use daylight saving time in the summer, except 
those near the equator. On Top Of The World knows about this and will usually do the right thing 
if you choose Auto.      Daylight saving time is never used with Universal time.



Set Time
The Set Time dialog in the Time menu lets you set the simulated time that On Top Of The World 
uses to display the world.    Normally, the simulated time is the true time, but you can set the 
simulated time to anything you like, without affecting your computer's clock.    The status bar 
displays the simulated or true time.

You can set the time either by using the slider, by typing in a Time Change (hours:minutes), or 
by typing in a whole New Time (hours:minutes).    In New Time,    you can use AM or PM or a 
24 hour    notation (for example, 2:00 PM = 14:00).    The slider is easy, because both Time 
Change and New Time update themselves as you use the slider, and as time passes.



Set Date
The Set Date dialog in the Time menu lets you set the simulated date that    On Top Of The World 
uses to display the world.    Normally, the simulated date is the true date, but you can set the 
simulated date to anything between 1 AD and 9999 AD, without affecting your computer's clock. 
Just type in the day of the    month, and the year, and choose the month from the list.    This does 
not affect the time of day.

Set To Today sets the simulated date to the true date, but does not affect the time of day.

This is very useful for demonstrating how the seasons work.    If you set the date to June 21, for 
example, you will see the    Arctic in continuous sunlight.



Compass Icon
The Compass Icon shows a compass rose with N,E,S,W directions marked. It displays a "+" sign 
to show the compass heading or azimuth of your view of the world.    The distance between the 
center and the "+" sign indicates your elevation. If you click on the Compass Icon, it changes 
your azimuth and elevation. If you click anywhere inside the central circle, you will be looking 
straight down (0 elevation and 0 azimuth).

You can turn the compass icon on or off from the    Show menu.



Latitude is the distance north or south of the equator measured in    degrees.    Latitudes range 
between -90º or 90ºS (the South Pole),    to +90º or 90ºN    (the North Pole). The equator is at 
latitude 0º.



Longitude is the distance east or west of the Greenwich meridian, measured in degrees (º).    The 
Greenwich meridian runs north/south through    Greenwich, England, a suburb of London.    
Longitudes range between    180º west to 180º east.



A degree is the unit of measure for angles.    There are 360 degrees    (360º) in a whole circle.    
The distance between the equator and the North Pole is one quarter of a circle, or 90 degrees.    
Fractions of degrees can be expressed as decimals or as minutes, which is the traditional way, 
and still widely used.



A minute is 1/60 of a degree.    It is abbreviated as '. For example, 45.50º = 45º30'. Minutes are 
the traditional way to express fractions of degrees, and they are still widely used.    A second is 
1/60 of a minute,    but On Top Of The World does not use them.
Of course, the other definition of a minute is 1/60 of an hour.



Universal time is the local time of Greenwich, England.      Universal time is used in aviation, 
astronomy, the military, and anywhere that    local times would cause confusion.      Universal 
Time is never adjusted for daylight saving time. All the time zones of the world are based on an 
offset from Universal Time.      It is abbreviated UTC or GMT, and is sometimes called 
Greenwich Mean Time.



Local time is a time that is used in a particular location.    In On Top Of The World, the location is
the one shown in the status bar.    Local times are set so that the sun crosses overhead at 
approximately 12:00 Noon.



A time zone is a geographical area that uses the same local time.      About 38 different time zones
are used in the world.    They are all based on offsets from Universal Time.



Home time is the local time that your computer's clock is set to. On Top Of The World needs to 
know this to determine the Universal Time from your    computer's home local time.    All the 
world's times are referenced to    Universal Time.    The position of the sun is determined by the 
Universal Time.



Setting the Home Time Zone
When you first install On Top Of The World, it prompts you to set your home time zone.    You do
this by clicking on your home location on the world. You may move around the world to find 
your location before clicking on it. Then it prompts you to confirm the location.

 If you live in a country with only one time zone,    you may not have to click on it.

 If you have your computer's clock set to Universal Time then click on    the North or South Pole.

The home zone setting is permanent, but you can change it if you change the time zone that your 
computer's clock is set to.    Change it by choosing Set Home Zone... from the time menu.



Because of the tilt of the earth's axis, during part of the year the northern half of the earth gets 
more direct sunlight and more    hours of sunlight per day than the Southern Hemisphere.    This 
is summer in the Northern Hemisphere.    Half a year later, the situation is reversed, and we have 
winter in the north.



Elevation is the direction you are looking relative to the ground. If you are standing on the 
ground, 0º elevation is looking down    at your feet, and 90º elevation is looking straight out at the
horizon. In On Top Of The World, you are always high above the ground, so the horizon is at less
than 90º elevation.

Elevation can also mean height above sea level of something on the earth's surface, but we call 
that altitude.



Azimuth is the direction you are looking or heading, measured along the    horizon. Another 
name for azimuth is compass heading. 0º is north, 90º is east, 180º is south, 270º is west.



Altitude is the height above the surface of the earth. Since your view point is out in space, its 
altitude is measured in    kilometers, miles, or nautical miles, The altitude of a mountain is 
measured in feet or meters.



A mile is 5280 feet or 1.609 kilometers.



A kilometer is 1000 meters or 0.621 miles.There are 10,000 kilometers from the equator to the 
North Pole.



A nautical mile is 1.15 miles or 1.85 kilometers. A nautical mile is equal to one minute of 
latitude. There are 5,400 nautical miles from the equator to the North Pole.



How Do I...
Find out where I am?
Find out what I am looking at?
Explore the world?
Find the distance between two locations?
Find out what time it is in a distant location?
Set my home time zone?
Change the time zone abbreviations?
Tell when the sun will rise or set?
Tell what day of the week I was born on?
Tell how seasons work?
Play a demo file?
Record a demo file?
See the world from the Space Shuttle?
See where my house is?
Get information about a location?
Add my own information about a location?
Put my town (or any place) on the globe?
Find the location of a telephone area code or country code?
Find the country for a radio call sign?
Tell what direction to point an antenna to a distant location?
Find out what country an airplane is from?



If you want to know what countries or cities are below you, just click on them.    They are 
identified in the status bar.

If you want to know what geographical coordinate you are at, use the move dialog.    It displays 
your position, and you can change it.



What Time Is It?
It is very easy to tell what time it is anywhere in the world. Just click on the location with your 
mouse.    If things are set right,    the time appears in the status bar    at the bottom of the view 
window. 

First make sure that the Time Zone for Display is set to Local in the Zone and DST dialog 
(from the Time menu). Daylight Saving should be set to Auto.

Make sure that the status bar is showing. If not, check Time Bar in the Show menu,    to turn it 
on. Also make sure the time being displayed is True.    If not, choose Reset To Now from the 
Time menu.



Changing Time Zone Abbreviations
The abbreviations for the time zones    that appear in the time display in the status bar    can be 
changed if you don't mind editing a file by hand.

To change the abbreviations, edit the file ontop.ini in your windows directory using Notepad or 
the equivalent.      The [Time Zone Name] section contains lines like
Zone04=EST,EDT,-300
This means that the time zone EST (Eastern Standard Time) is 300 minutes behind Universal 
Time, and it is abbreviated EDT when daylight saving time is in effect. Each abbreviation may 
be up to 5 characters, and    there may be up to 40 named time zones.    The order does not matter.
Each time zone must have a different number and a different offset from Universal Time.



The Time Display
The status bar displays the time. The time may be true, which means it is the true time 
somewhere in the world, assuming your computer's clock is correct. Otherwise, the time may be 
simulated,    in which case it is labeled as simulated and is drawn in red.

The time may be for any time zone.    You can tell which time zone it is by the abbreviation after 
the time.    EST, for example, is Eastern Standard Time, which is the time zone of the east coast 
of the USA during the winter. It is possible to    change the time zone abbreviations.

Not all time zones have abbreviations.    Those that don't are indicated by UTC with an offset in 
hours. 



Distance and Direction
Finding the distance between two locations is easy. First make sure the Feature Window is turned
on in the Show menu. Then click on the first location, then the second. The feature window 
displays the distance,    expressed in your choice of kilometers, miles, or nautical miles. This 
distance is very accurate, within a mile or two, even across half the world.

The feature window also displays the azimuth of the shortest route from the first point to the 
current point.      This is the direction to point an antenna if you are at the first point, and want to 
communicate with a station at the current point.

In the Options menu, if the    Distance Origin is set to Previous, these measurements are from
the last point to the current point you clicked on. If the Distance Origin is set to Fixed,    all 
the measurements are from the same point. You set this point by clicking on Set Origin.

If you are measuring the distance between two points that are both within    the same feature, the 
feature window may display something like "Colorado 291 Mi at 90º from Colorado".    This just 
means that two points in the same state are 291 Mi apart.



Time of Sunrise or Sunset
To find the time of sunrise or sunset, first go to the location you are interested in.    Then there are
two methods :

One is to use the Set Time dialog from the Time menu to adjust the time. For sunset, experiment 
with the time until the area to the west is sunlit, and to the east is dark.    For sunrise, it is 
opposite.

The other method is to set the Speed Factor from the Time menu to get the world moving fast 
(try 120x). Then just wait until you see the sun rise or set.

The sunrise and sunset times depend on the season, so make sure the date is set to the one you 
want.    These times are accurate, usually within 5 minutes.



Dates and Days of the Week
Use the Set Date dialog from the Time menu to set the date to your birth date, or your 1000th 
birthday, or whatever date you are interested in. The date, along with day of the week, appears in 
the status bar. Make sure that Time Bar is checked in the    Show menu, to turn on the status bar. 
The date must be between 1 AD and 9999 AD.



The View from the Space Shuttle
On Top Of The World lets you orbit the earth in a circular orbit. The amount of time it takes to 
orbit the earth depends on your    altitude.        It is about 90 minutes of simulated time at 250 km, 
which is a typical altitude    for the Space Shuttle.    It takes longer at higher altitudes.

To start your orbital flight, just choose Orbit from the move dialog.

You are moving fast when orbiting, as much as 21000 km/h (17000 mph), so don't set the Speed 
Factor more than about 12.

An orbit is a circular or elliptical path around the earth.      The things you pass over depend on 
the orbit's inclination. If you orbit around the equator (inclination of 0),    you only see things 
near the equator.    In On Top Of The World, your orbital inclination is equal to the latitude where 
you start your orbit.    This means you eventually pass over everything between this latitude, and 
the opposite latitude.    You pass over new things on each orbit, because in the 90 minutes or 
more that it takes, the earth has rotated. Try it, and enjoy the view.



You can't see your house or your street in On Top Of The World, unless you put it there yourself.  
On Top Of The World is meant to give you a global perspective, as if seen from space, so the 
smallest things you can see are cities, mountains, and major airports. 



Getting Information
You can get different amounts of information about places on the earth. The status bar gives you 
just the name of a place, and what time it is there.      The feature window gives its name, its 
distance from another place, and possibly the population of a city, or the height of a mountain. 
Info in the Feature menu starts up a hypertext version of the CIA World Factbook, which gives 
information on    countries, US states, and Canadian Provinces.



The status bar is the strip along the bottom of the main view window that can display Time and 
the current Feature or place.      If there is no status bar, the main window may be too narrow to 
display it, or both Time and Place may be turned off in the    Show menu.

The time is displayed in red if it is not the true current time.    The place name is grayed out if it 
is beyond the horizon.



The Button Bar

The button bar is the little row of buttons along the top of the main view window. The blue 
arrows on the left change your altitude.    The black arrows on the right move your view point 
around the world.    See the Move dialog for more information on moving. The "+" button sets 
your view to look directly down on the current feature displayed in the status bar.
You can turn the button bar on or off using the    Show menu.



The Arrow Keys
The arrow keys on your keyboard can be used for moving and changing your view direction.    
The keypad arrow keys (keypad 2,4,6,8) change the direction of your view.    You can also do this
with the    compass icon, or with the View Direction dialog. 

The regular arrow keys, between the keypad and the regular keys, move you over the earth.    The
Page Up and Page Down keys change your altitude.    You can also move yourself with the    
button bar or with the    Move dialog.    The Home key moves you way out into space, and the 
End key moves you down almost as close as possible.

If you hold down the Ctrl key, each arrow key moves about 3    times as far as normal, so you 
can move rapidly. If you hold down the Shift key, each arrow key moves about 1/3    as far as 
normal, so you can adjust your position precisely.



A physical map or globe shows the different kinds of land in different colors.    In our case, green 
represents lowlands, and yellow is high elevations and deserts.    To see different countries, you 
need political map or globe.



A political map or globe shows the different countries or states of countries in different colors.    
To see different kinds of land, a physical map or globe is what you need.



On Top Of The World displays images of the world that are true perspective views from a point in
space.    It simulates what a camera, or eye would see from that point.    Moving the    viewpoint 
changes the view, and so does changing the    direction that the camera is looking.



Feature Window
The Feature window gives details about the feature you are visiting,    and the previous feature.    
The population may be given for a city, and the altitude for a mountain.      The latitude and 
longitude are given for all features.

This window also gives the    distance and direction from the previous feature to the new feature.



You can turn on On Screen Labels in the Show menu, and a white label will appear on the screen
whenever you click on a new feature. The label gives the simple name of the place you clicked.



A Great Circle route is a curve that is the shortest route between    two points on the earth.    You 
can turn this on in the Show menu,    and a white Great Circle    curve will appear whenever you 
click on a new feature.    It runs    either from the previous point to the new feature, or from a 
fixed point to the new feature.

If you are used to looking at world maps, instead of globes, the shortest routes between certain 
places may surprise you.



The horizon is the curve on the earth's surface that is the farthest that you can see from your 
current view point. The horizon is actually a circle which expands as you increase your altitude. 
No matter how high you go, you can never see as much as half the earth.





The Shareware "Lite" Version
On Top Of The World LITE is a simplified version of the regular "full" version.    It is not just a 
demo, it is a useful program on its own.

These are the differences between the "lite" version and the "full" version:

The "lite" version is available as shareware    and can be downloaded from the Exploration 
Software Web page.
http://www.tiac.net/users/hlynka
 The "full" version is only available by mail order.

The "lite" version requires less memory and disk space. The install kit is small enough so it can 
be downloaded in just a few minutes.

The geographic data in the "lite" version has about half the amount of detail of the "full" version,
and the minimum altitude is twice as high as the "full" version.

The "lite" version doesn't have the following advanced functions that are in the "full" version:
File Menu:
Write BMP is not available, and neither is Record Demo. However, you can Play Demo.
View Menu:
Direction..., Grid Incr, and Colors are not available.
Feature Menu:
Calls..., Info..., Notes...,Add Custom..., and Delete Custom are not available.
Show Menu:
Great Circle is not available.
Options Menu:
All functions are available.
Time Menu:
All functions are available.

To find out about the functions you are missing, click on the hot links above.



How To Order or Register
If you use On Top Of The World LITE beyond the 30 day trial period you should register it by 
sending your name and address    (including email if available) and a check for $15.00 to the 
address below. We will mail or email a code you can use to turn off the shareware messages.

If you want the higher detail and more advanced functions of the "full" version of On Top Of The
World, just send your name and address (including email if available) along with a check for 
$29.95 to Exploration Software.    We will send your software by first class mail within a few 
days.    We pay the postage within the USA.

For orders to Massachusetts, please add 5% for sales tax.
For orders to Canada or Mexico, please add $2.50 extra postage.
For orders to anywhere else in the world, please add $7.50 extra postage.

Exploration Software
PO Box 961
Groton, MA 01450
email: hlynka@tiac.net
Comments and suggestions are welcome.

Unfortunately, we cannot take credit cards or Euro Checks.

These prices are in effect until June 30, 1996.



Shareware is a kind of software that is available on the honor system.    You may try the software 
without paying for it for a limited time, 30    days in the case of On Top Of The World.    Then, if 
you decide to keep using it, you need to register it.

You may freely distribute the shareware "lite" version of On Top Of The World, as long as the kit 
you distribute is the complete original kit, and you must not charge money for it, beyond the cost 
of your materials.






